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ECDL / ICDL Project Planning   
  

This module provides the essential concepts and skills relating to the use of project management 

software to prepare project plans and monitor projects including planning and managing time, costs, 

tasks, and resources.  

  

Module Goals   
  

Successful candidates will be able to:  

  

• Understand the key concepts relating to managing projects.  

• Use a project management application to create a new project and maintain an existing project.  

• Create and schedule tasks and add project constraints and deadlines.   

• Assign costs and create and assign resources to tasks.  

• View the critical path, monitor progress and reschedule work.  

• Prepare and print outputs, including charts and reports.  
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Using these notes 
This document falls into two parts. the first section walks you through a simple project. The second 

section is made up of the syllabus for the European Computer Driving Licence (or ECDL) Level 2 Certificate 

in project management. Strictly it was designed with Microsoft Project 2010 in mind. I have used this as a 

starting point for the ProjectLibre project management software. It is not a perfect fit but it’s a start. 

The Numbering in the second section corresponds to the ECDL syllabus numbering. 

 

The following line is intended to prompt you to have a go at doing something. It appears throughout the 

book and will help you to focus on the task in hand. 

 Do something 

The updated coursework notes can be found on my website www.giakonda.org.uk  

 

http://www.giakonda.org.uk/
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Project Management 
 

What is a project? 

One simple definition might be: 

A planned set of related tasks to be executed over a predicted period of time and within certain cost, 

resource and other limitations. 

 

What makes a project different from other work related activities? 

 They have specific objectives to deliver new benefits to, the company, their clients, the 

sponsoring organisation, stakeholders and/or delivery partners;  

 Often they introduce significant changes to the way the business operates;  

 They create new outputs/deliverables/practices that will enable benefits to be realised;  

 They have a specific, temporary management organisation and governance arrangements 

running alongside current company practices set up for the duration of the project;  

 They are susceptible to additional risks not usually encountered in the day to day running of 

the organisation;  

 Usually they involve a range of stakeholders from different parts of the organisation and 

beyond;  

 Sometimes they use methods and approaches that are new or unfamiliar to the adopting 

company.  

 

In what circumstances may a project fail? 

 Failure to take into proper account the needs and influences of stakeholders;  

 Failure to communicate and keep the stakeholders informed of developments;  

 Lack of attention to the impact of the additional project work on the normal business of the 

adopting company;  

 Producing expensive ‘Rolls Royce’ solutions when simple workable products would suffice;  

 Failure to identify and deal with the many risks that can affect achievement of project 

objectives;  

 Insufficient attention to planning, monitoring and control of the work of the project. 

 

Project management is the process of monitoring and control that ensures the smooth running of 

the project and minimises the possibility of failure. 

ProjectLibre is designed to manage resources usage and project scheduling. 
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Work Breakdown Structure (WBS) 

Displaying a complex project as simpler and more manageable tasks in a structure diagram is sometimes 

referred to as a Work Breakdown Structure (WBS). Also referred to as top down design by stepwise 

refinement. It is a technique used to define tasks first developed in the mid 1950’s by the US defence 

program to develop Polaris nuclear submarines.  

An example of a WBS for a project to build a computer is shown below. 

 

 

 

 

 

 

 

 

 

Exercise  

 Produce a WBS for Project 1 on the accompanying worksheet. 

 

 

  

Starting a project 
Initiating a project 

Document 
Running a project Closing a project 

Benefits 
realisation 

The Project life cycle 

Running the project is the most resource intensive part of the project but it is the 

start-up and initiation and the planning that goes on there that ultimately has the 

most impact on its success. 
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Title Bar 

Ribbon Tabs 

Gantt Area Task Area 

(Spreadsheet) 

Sub windows 

Quick Access bar 

Introducing ProjectLibre 

What is ProjectLibre 
ProjectLibre is the project management software produced and supported by the ProjectLibre 

community. It is a very useful tool for planning a project including the management and tracking of 

resources and time. There are several other Open Source programs that offer similar features such as 

TaskJuggler and OpenProject. 

 

The Start-up Screen 
When you first start Project the screen will look similar to the screen below. 

The area on the left is the area where you enter the individual tasks that make up your project. The area 

on the right displays the information in the form of a Gantt chart. 

The ribbons in ProjectLibre are similar to the ribbons in the Microsoft Office suite. From 2007 on. 

The icons on the ribbons are often called commands, however I prefer to use the term tools as they allow 

you to perform some sort of action just like the normal use of the word tool. 

 

 

 

Title Bar 
This tells you the name of the project you are working on, in this case Home Office 

Quick Access toolbar 
This allows you quick access to the commands you use frequently. Save Undo and Redo. 

Save saves a copy of your current work. Undo undoes the last action you applied to your 

project and Redo simply undoes the undo action, i.e. puts you back to where you were. 
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The Ribbon 
This is an easier way of displaying the tools available in a particular menu.  It replaces the 

idea of drop down menus which tended to hide the functionality of a program. There are 

four ribbons in ProjectLibre each with its own set of tools icons that provide a context 

sensitive focus. Each ribbon tab provides the tools for a particular set of actions or 

commands within ProjectLibre. For example the View tab includes tools for producing 

reports. Each ribbon is sub divided into several groups, each separated by vertical lines. The 

group name appears underneath the tools. 

 Make a note of the groups in the View ribbon 

Ribbon Tabs 
File, Task, Resource, and View tabs are always present. The File tab gives access to actions 

such as Save, Open, Close and New which of course applies to the Project files themselves, 

hence the tab name. 

Ribbon groups 
On each of the ribbons there are many tools, the Ribbon itself has been sub divided into 

groups. Each group displays the tools of that group. 

Gantt Chart 
This is divided into two parts. On the left is a table of the tasks to be undertaken and on the 

right is the Gantt chart proper which is a graphical representation of the project schedule.  

Sub-Window Bar 
This bar to the right of the tabs includes the tools to add sub-windows (Below the Gantt 

Chart) and the Help tool  

 

From left to right the sub-windows are: 

Histogram, Charts, Task Usage, Resource Usage and No Sub Window and on the far right the Help 

button. 

Tool Tips 
If you hover the mouse pointer over any icon on the ribbon then the name and purpose of that icon is 

displayed. 

Getting Help 
To get help, you click on the help button on the top right of the screen. It is the white question mark on 

the left of the Title bar.  

 Look for help on setting a start and finish date 
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Starting a new project 

Basics 
To follow this tutorial it is best if you download the Workfiles from www.giakonda.org.uk look for 

downloads then ProjectLibre . 

Open a new project by launching ProjectLibre. This automatically displays the Welcome to ProjectLibre 

dialogue box that prompts you to either create a new project or open an existing one. 

 

 

 

 

 

 

 

 

Creating a new project displays a further dialogue box where you can enter the basic details of your 

project, its name, the manager of the project and its start date. 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

http://www.giakonda.org.uk/
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Selects all Saturdays 

Enter times here 

Further details can be set using the Project Information tool found on the File ribbon in the Project 

group. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Next to be looked at is the Working calendar. Generally the default working calendar is sufficient but for 

some projects it may be appropriate, for 

example for there to be working time on 

Saturday morning. To set this as an option first 

select the days you wish to change. So for a 

project where every Saturday morning was a 

working morning click on the S for Saturday 

and then set the non-default working time to 

include 8:00 to 12:00. I.e. delete the entries 

13:00 and 17:00. If you wanted only a few 

Saturdays to be set this way then you could 

select only the actual days you wanted to 

change. 
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1 Data entry sheet 

 Before starting to enter data into your project adjust your working time settings to reflect 

this project involves working Saturday mornings from 9:00 to 12:00.  

Entering Tasks 
Now we need to start to enter the Project tasks.  

From the ProjectLibre Coursework you downloaded from www.giakonda.org.uk enter the tasks and their 

duration. Note the three summary tasks will NOT require any days to be entered. These will be 

automatically updated when the task entries are properly finished. As each task is entered a duration of  

1 day? is entered alongside it. If you did not have any duration data at this stage simply leave that alone 

until you can come up with some. 

Having completed this list you should see something like: 

 

Note: The three Phases Ground Work Roof and Interior will not require you to enter a duration. These 

will be calculated by the software once their respective tasks have been properly placed 

  

http://www.giakonda.org.uk/


  

[Type text] 
 

Select tasks then 

Indent 

2 Selected Tasks prior to Indenting 

To include the tasks from Level to Brickwork as sub-tasks of Groundwork simply select them all and on 

the Task ribbon use the Indent tool. Ground Work then becomes a Summary Task. 
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The finished Task Sheet should look like: 

 

3 Finished Task Sheet for Home Office 
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5 Task list and Gantt chart for Home Office after linking 

Gantt Chart 
The Gantt chart is the diagram of the tasks and the times required to complete them. So Tasks are on the 

left side of the screen and the Gantt chart proper is on the right side of the screen. Once all the tasks 

have been entered notice they all align themselves to the Start date. It is now necessary to link them in 

such a way as to ensure they start as required that is after the appropriate preceding task. If you entered 

the tasks in the order you intend to complete them then this linking is relatively straight forward.  

 

4 Tasks before Linking 

Highlight the tasks you want to link. From the Task ribbon Task group click the Link tool.  

The completed Task List and Gantt Chart should look like: 

 

A Summary task on a Gant Chart is a special task that includes a set of sub-tasks. It provides a convienient 

way for you to hide the detail of a progect when it is not needed. 

Click to contract/expand 
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6 Tasks as Summary only for Home Office 

To add a sumary task highlight the sub-tasks then on the Task ribbon Insert group click the Summary tool 

 

 Once these tasks have been added link them so that they follow each other. Make sure the 

links are Finish to Start links 

 

 From the project create 3 Summary Tasks:  

GroundWork: Level, Drainage, Footings, Blockwork, Concrete Base, Floor, Brickwork 

Roof: Timbers, Felt, Tiles 

Interior: Windows and Glazing, Doors, Electrics, Plumbing, Plastering, Snagging, 

A Milestone is an event that marks a critical point in the project. Generally any task that has no duration 

is marked as a milestone though any task can be.  

To mark a specific task as a milestone open the task by double clicking the row then in the Task 

Information dialogue box under the Advanced tab tick the Display task as milestone check box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

7 Advanced Task Information: Set Milestone 

 Make the Handover task a milestone. 
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Creating Resources 
Using the information on the worksheet add the resources to the project Home Office.pod 

Click the Resource tab and in the Views group click the Resources tool. The Resources screen appears. In 

the Name column enter the names of the resources. For the resource Type leave the selected at Work.  

 Add the people resource to the project with the parameters supplied. 

 Save the project as Home Office Resource.pod 

 

 

Finally (in this example) enter Bricks as a material. Type Bricks in the Name column and click the Type cell 

then select Material. We will label these items as ,000 in the Material Label column since bricks usually 

come in thousands. In the Standard Rate column enter the cost of 1,000 bricks which would be £200. 

Note: When we assign bricks to the Brickwork task we will need to remember we are assigning them in 

1,000s 
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Assigning Resources 
Having entered the resources to the project assign these as appropriate. 

Make sure the Task ribbon is displayed by clicking on the Task tab. To assign a resource to a task first click 

on the Task then from the Task group click on the Assign Resources tool  

Click Assign for each resource allocated to the task selected 

 

8 Assign Resources Dialogue 

Note: The Assign Resources dialogue box can remain open while you move through the tasks and you 

can Assign Remove assignments or Replace one assignment with another. 

You can also make multiple assignments to the same task. 

 Assign the resources to the tasks as appropriate (see worksheet for details). 

 Save the project as Home Office Assigned.pod 

 

9 Completed Gantt with assignments 
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Baseline 
Having entered all the details of your project generally you are ready to commence work. At this point it 

is worth setting a point of reference, a Baseline. This is a snapshot of what you expect to happen over the 

life of the project. As with all projects I have attempted things will happen that were not anticipated and 

often quite out of your control. Comparing the situation as is with the original plan is essential to keeping 

the project on course. You can set up to 10 baselines in your project perhaps mirroring the phases of your 

project. At the end of the project you can use the baselines and the final outcome to review your 

achievements. 
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ECDL requirements 

1 Project Management Tools 

.1.1 Key Concepts 

1.1.1 Understand the term project.  
A project is an organised collection of tasks to be executed over a predicted period of time and within 

certain cost, resource and other limitations. 

1.1.2 Recognise the main elements of managing a project like: planning the project, 
managing the schedule, communicating project information.  

 

The five essential elements of project management are; 

Initiate, Plan, Monitor and Control and Close. If these are the bricks of project management then 

communication is the mortar that binds them. 

Initiate 

Close 

All projects eventually lead to closing, where the project is accepted and brought to an organised end. 

The two main components of closing are contract closeout, in which any remaining open items are 

resolved and the contract is settled, and administrative closure, the gathering of documentation to 

formalize project completion, this phase usually includes some form of critical review. This is often 

helpful in guiding future projects. 

1.1.3 Understand the advantages of using a project management application like: 
efficient project design, ease of project plan maintenance, effective activity 
representation, ease of monitoring and reporting.  
It is pretty clear to all of us by now that we live in a digital era. Even more than some of us we would 

choose to. Mobile phones, tablets laptops and PCs are working towards minimizing face to face 

interaction. So what are the real advantages of Digital Project Management? 

Improved estimation. 

Having a software do the estimation for you can greatly improve the whole process of estimating the 

time and resources needed for a particular project. This is often the keystone in project management. It 

will be there following you though your whole project, and helping you make the right decisions.  

Greater control. 

Having all your documents on one database (and hopefully backup frequently) can give you greater 

access and control over all your documents relating the project. This means greater control of the 

documents whether you are at the office, at home, or have taken a leave of absence because of an 

emergency. This also means time saved in runs between offices. 

Easier tracking. 

With digital project management you now have software installed on yours and your employee’s 

computers. That means looking up who is working on what is just a few clicks away. You can easily track 

your resources and intervene before things get out of hand. 

Measuring results and comparing projects. 
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When all is said and done, you have to see what has been achieved, and just as importantly what has not 

been achieved. If you manage some independent projects and wish to see which one has been better, or 

simply look back on finished projects and see if your team is making any progress your software solution 

will be there to help you find answers. 

 

1.1.4 Understand the tools and features of a project management application like: 
Gantt chart, network diagram, work breakdown structure.  
??? 

 

1.1.5 Recognise that managing projects involves balancing work, time, resource, and 
cost.  
You can have it good, fast, or cheap. Pick two! 

Engineers have been saying this to project managers for decades. 

In slightly different terms, every project balances a “triangle” of time, money, and scope you can’t change 

one without affecting at least one of the others. The project manager’s job is to keep the whole triangle 

from falling apart. 

All projects involve a compromise, usually cost and time are the biggest constraints. Project management 

software helps the visualisation of these constraints. 

Time + money + scope = quality 

The project triangle is also known as the “iron triangle” or the “triple constraints.” Whatever it is called, it 

amounts to the same thing: You can’t change a project’s budget, schedule, or scope without affecting at 

least one of the other two parts. [Scope=Features] 

  

Examples of how this works 

To bring in the finish date (time), you could spend more in resources (money) to finish the work 

faster or cut features (scope) so there’s less work to do before the new deadline.  

To finish the project under budget (cost), you could get rid of overtime and finish the project later 

(time) or cut features (scope).  

To add features to a product (scope), you could extend the deadline to make time for the new work 

(time) or add people to get it done faster (cost). You could also do both!  

In most projects, at least one side of the triangle is fixed in place. It can’t be changed.  

Maybe the budget is non-negotiable. Maybe the product absolutely has to go on live by a certain date. 

Maybe both are true.  
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2 Project Creation   

2.1 Working with Projects 

2.1.1 Open, close a project management application. Open, close projects.   
Launching ProjectLibre 

Ubuntu Linux: In the Search programs box type Project > Click on the ProjectLibre icon. If you prefer drag 

the icon to the side bar  

Windows 7: Click Start > All Programs > ProjectLibre > ProjectLibre 

Windows 8.1: Launch ProjectLibre by typing the application name on the Start Screen 

2.1.2 Save a project to a location on a drive. Save a project under another name to a 
location on a drive.  

 

You are prompted to enter the name of your project on startup. This is automatically saved to your 

documents file. To change the destination or file type select the File tab and in the File group click Save 

as. You can save a file as either a ProjectLibre (.pod) file or a Microsoft XML (.xml) file 

2.1.3 Save a project as another file type like: template, web page, spreadsheet, CSV, 
XML, text file, pdf.  
If you want to change the name or location of your file then  

On the File tab File group click Save As and in the dialogue box enter the new File name. Select from the 

Files of type dropdown the type of file required either a ProjectLibre (.pod) file or a Microsoft XML (.xml) 

file. To save your project as a .PDF file use the PDF tool in the Print group of the File ribbon 

 

 

 

  

Save as PDF 
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2.1.4 Change between project view modes like: Gantt chart, network diagram.  
There are two ways of doing this 

From the View ribbon use the tools in the Task, Resources or Other Views group to select the view 

required 

 

Alternatively select the view required from the View tools on the right of the Tab Bar 

 

 
 

2.1.5 Use magnification/zoom tools.  
 

 
 

2.2 Starting a New Project  
 

2.2.1  Create a new project based on default template, other available template.  
From the File menu (Sometimes called the back stage view) select New then select a blank project, a 

template option or other desired project option. 

2.2.2 Understand how choosing to schedule from a start date, finish date will impact 
on the project schedule.  
Note: Nearly all projects should be scheduled from a known start time. Even if you know the date that a 

project must be completed, scheduling from a start date will give you maximum flexibility. 

When you create a new project, you first enter the project's start date. When you schedule a project 

from the start time, all tasks start at the project start date unless you specify otherwise. 

For both manually and automatically scheduled tasks, with no task dependencies or constraints, the 

project's duration is the same as the duration of the longest task. In other words, the project finish date is 

the same as the longest task's finish date. 

Task dependencies, such as the finish-to-start dependency between the first and second tasks can change 

the project's finish date. E.g. for two tasks where the start of the second task begins with the end of the 

first task the end of the project is the end of the second task. 

11 Zoom from Task Views 

10 Zoom from Resources Views 
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There are however, occasions where you might want to schedule from a finish date: 

1. You need to determine when a project must start so that it finishes on a specific required date. 

2. You are not sure when your project will begin (for example, you are receiving work from another 

source that could be delayed). 

3. Your companies project management methodology requires you to schedule from a finish date. 

If you work with your project that is scheduled from a finish date, you need to understand the differences 

in the way that Project handles some actions: 

1. When you enter an automatically scheduled task, Project automatically assigns the As Late As 

Possible (ALAP) constraint to the finish date of the task. You should set other constraints only 

when necessary (By right-clicking a task, then click Task Information). 

2. If you drag a Gantt bar to change the finish date of a task, Project automatically assigns a Finish 

No Later Than (FNLT) constraint for an automatically scheduled task. 

3. If you change your project to schedule from a finish date and it was previously scheduled from a 

start date, you will remove all levelling delays and levelling splits from tasks and assignments 

that have been automatically scheduled. Tasks that are manually scheduled are not affected. 

4. If you use automatic levelling to reduce resource over allocations in your project, Project will add 

a levelling delay after a task rather than before a task (To check levelling settings, click the 

Resource tab, and then click Level Resource). 

 

 

2.2.3 Enter basic project information such as start date or finish date, scheduling 
options and project properties like: project title, project manager.  
The finish date is the date that a task is scheduled to be completed. This date is based on the task's start 

date, duration, calendars, predecessor dates, task dependencies, and constraints. 

 

2.2.4 Set up calendar options like: base calendar, working time, nonworking time.  
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3 Tasks   

3.1 Creating Tasks 
Tasks are the activities which must be completed in order to complete the project. Tasks form the basis 

of the project plan. Before entering the tasks into the project it is a good idea to produce a list of these 

tasks and ensure this is as detailed as possible. It makes life easier if the list of tasks are entered in the 

order they will be performed. 

Don’t make the mistake of generating this list with only a few people. Involve all the Stakeholders! 
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12 Task Information Dialogue Box 

3.1.1 Create, modify tasks.  
It is usual to start entering tasks in Gantt Chart View. To display this click the Task tab to display the Task 

ribbon then in the Views group click the Gantt tool.  

 

Before entering the task decide on the Task Mode to use Manually Scheduled tasks rely on the user to 

enter the start and finish dates. They are not updated by ProjectLibre and do not link to other 

dependencies. Choosing this option can make things very time consuming. The default, Auto Schedule 

automatically calculates the start and finish dates, along with the duration based on dependencies, 

constraints, calendar and other factors. On the spreadsheet side of the display enter the name of the task 

in the Name column add the duration of the task in the Duration column and the start date, if known, in 

the Start column 

A task can be modified either by changing the data directly on the Gantt chart, or by using the 

Information tool dialogue box, which is found in the Task ribbon Task group. 

 

 

3.1.2 Copy, move, delete tasks.  
A task can be copied moved and deleted from the Gantt chart view. The column representing the task is 

13 Task Information tool 
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selected with the mouse pointer in the task number column. The row selection pointer changes to a 

move pointer and the task can be dragged to its new location. To Delete the task completely either right 

click the mouse and select Delete Task, or use the Clear tool in the editing group on the Task ribbon. Click 

Entire Row. 

 

 

 

 

3.1.3 Create, modify, view subtasks and summary tasks. 
A Task can be made a Summary Task of a set of other successor tasks by selecting the successor tasks and 

then indenting them using the Indent tool on the Task group in the Task ribbon. 

 

 

 

To remove a task from a summary task simply use the Outdent tool 

 

  

1. Select the tasks to be summarised 

2. Click the Indent tool to 

summarise these under Ground 

Work 

14 Creating a Summary task 

Ground Work Summary task expanded 

Roof and Interior tasks contracted 
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3.1.4 Understand task duration options: elapsed, duration, effort, estimated. 
 Task Duration information is found in the Task Information Dialogue. To display this click the Task tab 

and in the Task group click the Information tool.  

 

3.1.5 Set, modify task duration.  
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3.1.6 Split tasks.  
In order to split tasks use the Gantt chart to select the task then right click the mouse and select Split. 

 

15 Task Shortcut menu in Gantt view 

This tool generates a Split marker that will split the task when you move the cursor. 

 

3.1.7  Understand the term milestone.  
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3.1.7 Understand the term milestone. 
A milestone is an event that marks a critical point in the project. 

3.1.8 Create project milestones.  
To mark a task as a milestone first display the Gantt chart view by clicking the Task tab then click on the 

Gantt view tool in the Views group. 

Select the task you want in the Name field, and then use the Information tool in the Properties group. 

Display the Advanced dialogue by clicking the Advanced tab. Tick the Display task as a milestone tick 

box. 

 

It is also possible to add a milestone as a task in its own right.  

Select the Gantt view 

Type the milestone name in the first empty row or pick a task you want to turn into a milestone. 

Type 0 in the Duration field, and then press Enter. 

Any task that has a 0 duration is by default set as a milestone. 

3.1.9 Create, modify recurring tasks.  
Currently ProjectLibre does not support recurring tasks. 
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3.2 Scheduling and Relationships  

3.2.1 Understand logical relationships between tasks: finish to start, start to start.  

Finish-to-Start link (fs) 

 

 

Task B can’t start until Task A is done. This is the 

default link type in Project, and the most 

commonly used. 

Example: Dig foundation (Task A) must be 

complete before your team can start Pour 

concrete (Task B). 

Start-to-Start link (ss) 

 

 

Task B can’t start until Task A starts. They don’t have 

to start at the same time: Task B can begin any time 

after Task A begins. 

Example: To save time, you want to level concrete at 

one end of the foundation while it is still being poured 

at the other end. But Level concrete (Task B) can’t 

start until Pour concrete (Task B) has also started. 

Finish-to-Finish link (ff) 

 

 

Task B can’t finish until Task A is done. They don’t 

have to end at the same time: Task B can end any 

time after Task A ends. 

Example: Your team is adding the wiring to the 

building and inspecting it at the same time. Until 

Add wiring (Task A) gets done, you won’t be able 

to finish Inspect electrical (Task B). 

Start-to-Finish link (sf) 

 

 

Task B can’t finish until Task A begins. Task B can finish 

any time after Task A begins. This type of link is rarely 

used. 

Example: The roof trusses for your building are built 

off-site. You can’t finish Assemble roof (Task B) until 

Truss delivery (Task A) begins. 
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3.2.2 Create, modify, delete relationships between tasks: finish to start, start to start.   
To create a link between two tasks highlight the first task then, while holding the Ctrl key, highlight the 

second task. Finally from the Task ribbon use the Link tool in the Task group to create the link. Unlinking 

simply involves selecting the tasks as before and then clicking the Unlink tool. 

When you link two tasks, Project creates a finish-to-start dependency between them. By 

default the second task can’t start until the first task finishes. This is only one of the four possibilities as 

shown below.  

To change a link type: 

Click View > Gantt Chart. 

Double-click the link line between the two tasks. 

  

 

 

 

 

 

Pick a dependency type from the Type list.  

 

FF finish to finish 

FS finish to start 

SF start to finish 

SS start to start 

 

To get rid of the link entirely, click Remove from the Task Dependence dialogue box. 

3.2.3 Understand the terms lead time, lag time.  
Lead time 

Lead time is an overlap between two tasks that are linked by a dependency. For example, if a task can 

start when its predecessor is half finished, you can establish a finish-to-start dependency and specify a 

lead time of 50% for the successor task. You enter the lead time as a negative value. 

Lag time 

Lag time is a delay between two tasks that are linked by a dependency. For example, if there must be a 

two-day delay between the finish of one task and the start of another, you can establish a finish-to-start 

dependency and specify two days of lag time for the successor task. You enter the lag time as a positive 

value. Adding lag time is a way to add slack (also called "float" or "buffer") to a task, increasing the 

amount of time the task can be delayed before it affects the start of another task. 

 

  

http://office.microsoft.com/en-gb/project-help/redir/HA102749316.aspx?CTT=5&origin=HA102840091
javascript:AppendPopup(this,'314685611_1')
javascript:AppendPopup(this,'348384514_4')


  

[Type text] 
 

3.2.4 Add, edit task lag time, lead time.  
 

Note: You can set lead time or lag time between tasks only after creating task dependencies. 

 

Click on the Gantt Chart view tool to display the Gantt chart view. 

Select the task you want in the Task Name field, and then use the Information tool in the Properties 

group. Display the Predecessors dialogue by clicking the Predecessors tab 

.  

16 Task Information Predecessors 

In the Lag field, type the lead time or lag time you want as a duration or as a percentage of the 

predecessor task duration. 

To enter lead time, type a negative number or negative percentage, such as -2d for two days of lead time. 

To enter lag time, type a positive number or percentage, such as 50% for half the predecessor task's 

duration in lag time. 

Note: You can quickly add lead time or lag time to a successor task by double-clicking the link line on the 

Gantt Chart view and entering the lead time or lag time in the Lag field. 
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3.3 Constraints and Deadlines   
3.3.1 Understand task constraint options like: as late as possible, as soon as possible, 

must finish on, must start on.  

Note: In nearly all cases, use the ASAP constraint. This gives the scheduling engine the most flexibility in 

determining the ideal finish date for your project. 

There are two ways to instantly view the constraints on your tasks. 

1. To review or change the constraint on a task, right-click on the task, click Task Information , then 

click the Advanced tab. Constraint information is in the Constraint type and Constraint date 

boxes.  

2. If the constraint is anything other than ASAP or ALAP, the constraint type will display its 

associated graphical indicator in the Indicator column in any sheet view, such as the Gantt chart.  

Constraints with moderate scheduling flexibility will restrict a task from starting or finishing before or 

after a date you choose. For example, a task with a Start No Earlier Than (SNET) constraint for June 15 

and a finish-to-start dependency to another task can begin June 15 if its predecessor is finished by June 

15 (or later if its predecessor finishes after June 15), but it can't be scheduled before June 15. For 

example, this might be appropriate use of constraints if you have a building permit that is only good for a 

specific dates. In this case, the SNET or FNLT constraints might be used. 

 

 

 

Note: It’s easy to confuse task dependencies (the links that show a relationship between two tasks) with 

task constraints (the restrictions on when a task can start or finish). 

3.3.2 Add, modify, delete constraints to tasks.   
Click on the Gantt Chart view tool to display the Gantt chart view. 

Select the task you want in the Task Name field, and then use the Information tool in the Properties 

group. Display the Predecessors dialogue by clicking the Advanced tab. Select the parameters as 

appropriate. The dialogue box below shows the Constraint type options. 
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3.3.3 Understand the term 

deadline.  
A Deadline is a target date showing 

when you want a task to be 

completed. If the deadline date 

passes and the task is not completed 

then ProjectLibre will displays an indicator.  

Deadlines are used if you want certain tasks in your project to finish by specific target dates and you don't 

want these dates to actually affect how Project schedules the tasks. Setting deadlines will allow 

ProjectLibre to alert you if the tasks are not completed on time.  

3.3.4 Create a deadline.  
To create a deadline  

Select the Gantt Chart view. Then double click on the Task itself. This opens the task information 

dialogue box 

In the Task Information dialogue box select the Advanced tab finally you can select the deadline date 

from the calendar opened with the Deadline dropdown. 
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3.4 Notes, Hyperlinks   

3.4.1 Add, edit, remove a note for a task.  
Click on the Gantt Chart view tool to display the Gantt chart view. 

Select the task you want in the Task Name field, and then use the Information tool in the Properties 

group. Display the Predecessors dialogue by clicking the Notes tab. Add the note in the Notes window. 

The dialogue box below shows the text Test lights and sound. 

 

 

 

3.4.2  Insert, edit, remove a hyperlink for a task.  
Currently ProjectLibre does not support hyperlinks 
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4 Resources and Costs 

4.1 Resources 

4.1.1 Identify resource types like: people, materials, equipment.  
Project operates with the types of resources Work and Material. 

A work resource: People and equipment resources that perform work to accomplish a task. Work 

resources consume time [hours or days] to accomplish tasks. 

Material resources: Consumable materials or supplies, such as concrete, wood, or nails. 

4.1.2  Understand the relationship between duration, work and resource. Understand 
that if one element changes there is an impact on another element.  
 

The calculation of Work, Duration, and Units is one of the biggest issues for new users of Project. This 

calculation is the core of what Project does and it cannot be turned off. So it is important to understand 

it.  

Duration = Work/assignment Units 

 

the assignment Duration (in hours) is equal to the assignment Work (in hours) divided by the assignment 

Units value. 

 

 

4.1.3 Recognise risk factors which may affect the delivery of the project like: non-
availability of resources, natural disaster, policy changes. 
There are very many risks that can cause a project to fail.  

 

4.1.4 Create, delete resources. Modify resource details like: name, type, units, rates. 
The most usual way to add a resource is to use the resource sheet view. To access this click the View tab 

and in the Resource Views group, click Resources tool. Alternatively click the Resource tool on the 

Resource ribbon. 

 

To add a resource enter its name in the Resource Name field. If you want to designate resource groups, 

then in the Group field for the resource name, type the name of the group. 

Specify the resource type. 

To specify that this resource is a work resource, in the Type field, click Work. 

To specify that this resource is a material resource, in the Type field, click Material. In the Material Label 

field, type the name for the units associated with the resource, for example, yards, tons, or boxes.  

javascript:AppendPopup(this,'675614022_2')
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In the Max. Units field for the resource, type the number of total units that this resource is available for 

this project. The maximum units value specifies how much of this resource is available for this project for 

example, part-time or multiples. 

For example, if you have a resource who is available for your project two days a week, you can enter a 

maximum units value of 40% ie 2 out of the 5 days. You can use maximum units to specify multiple 

availability of a resource designation. For example, suppose you have a resource named Engineers, a 

single resource that represents three individual engineers on your team. You can enter the maximum 

units for Engineers as 300%. You can schedule all three engineers for full-time work at one time without 

the Engineers resource being flagged as over allocated. 

You can enter maximum units as a percentage (50%, 100%, 300%), or as a decimal (0.5, 1, 3). 
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4.1.5 Add, remove, replace resource assignments and associated units. 
To assign a resource use the Gantt Chart view. Then display the Resource ribbon and use the Assign 

Resources tool in the Assignments group. This will display the resources for the project. Select the 

resources you want to allocate (Using the Ctrl key if the resources are non-contiguous). Click Assign in the 

Assign Resources dialogue box. 

 

By default Project assumes the resource will be used in full so the units column will display 100%.  

 

Note: With this dialogue box you can also Remove or Replace Resources 
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4.2 Costs  

4.2.1  Understand the terms fixed cost, variable cost.  
A fixed cost is a set cost for a task that remains constant regardless of the task duration or the work 

performed by a resource. 

 

A variable cost are referred to as rate-based resource costs. In most projects these costs are mainly made 

up of people costs.   

4.2.2  Assign, modify fixed costs. 
If you have costs that aren’t associated with any rate-based people or material resources, or other 

variable resource costs, you enter them on the cost spreadsheet as above.  

To do this click Gantt tool on the Views group of the Task ribbon. Focus on the spreadsheet on the left 

side. In the top left of the spreadsheet corner square right click. You now have a spreadsheet list. From 

this list select the Cost spreadsheet. You may have to move the Spreadsheet / Gantt divider to see the 

Cost column 

 

In the task Name column, select the task for which you want to enter a fixed cost. 

In the Fixed Cost column, type a cost amount. 

In the Fixed Costs Accrual column, cost accrual is by End default, but you can pick Start or Prorated to 

accrue the fixed cost at the start, end or prorated. 

 

  

17 Adding fixed costs 

Right click here to see the 

possible spreadsheets, 

select the Cost spreadsheet 

Spreadsheet 

Gantt divider 
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4.2.3  Assign, modify variable costs. 
In Resource sheet view select the Name of the resource in the Name column. Set the resource type to 

Work enter the standard rate for the resource in the Std. Rate column. For more control over the cost 

entry use the Information tool in the Resource group to display the Resource Information dialogue box. 

Note: You can also access this by double clicking the Resource in the Name column. 
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18 Critical tasks filter option 

5 Project Monitoring  

5.1 Critical Path     

5.1.1 Understand the terms critical task, critical path.  
Definition of critical task: A task or activity that lies on the critical path of the schedule, which if delayed 

will delay the completion of the project. 

Definition of critical path: Longest sequence of activities in a project plan which must be completed on 

time for the project to complete by the due date. 

5.1.3 Identify critical tasks and show the critical path.  
Every task is important, but only some of them are critical. The critical path is a chain of linked tasks that 

directly affects the project finish date. If any task on the critical path is late, the whole project is late. 

To show the critical path on the Gantt Chart 

Click the View tab to display the View ribbon click the Filter in the Filters group. Display the Critical Tasks 

option. 

 

 

 

 

 

 

 

 

 

Tasks on the critical path now have red Gantt bars.  

 

5.2 Monitoring Progress and Rescheduling 

5.2.1  Understand that collecting and analysing progress information is essential to 
controlling a project. 
 

Collecting and analysing progress information is essential to controlling a project. 

 

5.2.2 Recognise that regular project meetings inform stakeholders of issues to be 
resolved and anticipated difficulties. 
 

Regular project meetings inform stakeholders of issues to be resolved and anticipated difficulties. 
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5.2.3 Create, save, and clear a baseline. 
A baseline contains all the key information that makes up your project: tasks, resources, assignments, 

and costs. 

A baseline is required for tracking your project. Usually you would want to complete your project setup 

as much as possible before you set a baseline. The original parameters it contains are the reference point 

against which you can compare the progress of your project.  

Once you save a baseline, you can track progress by viewing the variances between baseline estimates 

and scheduled data. For example, if you estimate a task cost of £70 but record a scheduled cost of £90, 

the cost variance is £20. As you monitor variances you are more able to take steps to keep your project 

on track. Baseline information, and variances calculated from it, are used in a variety of views in Project. 

To see these effects in a sheet view, apply the Variances table or the Tracking table. 

Note: you can't track unless you have something to track against. So if you didn't enter resource costs 

before you saved a baseline, you will not be able to view resource-cost variances, and so on. 

If baseline information consistently differs from the current data then it is likely that the original plan is 

inaccurate. Often this is caused by changing the scope of the project. 

Note: A baselines in Project is a key tool for comparing actual progress with your original plans. Only by 

making these comparisons can you tell if your project really is on track. 

A baseline is a group of almost 20 primary reference points (in five categories: start dates, finish dates, 

durations, work, and cost estimates) that you can set to record the original project plan when that plan is 

completed and refined. As the project progresses, you can set additional baselines (to a total of 10 for 

each project) to help measure changes in the plan. For example, if your project has several phases, you 

can save a separate baseline at the end of each phase, to compare planned values against actual data.  

To set a baseline display the Task ribbon then in the Task group click the Save Baseline tool 

 

 

 

 

Pick the baseline you want to set. Usually the First.  

Click Entire Project. 

 

Note: You can set as many as 10 baselines in a single project. Do this to get frequent snapshots of where 

things stand. 

 

Note: You don’t need to take any special steps to save the baseline. When you save your project, the 

baseline is saved with it. 

 

Note: You can remove all the data from a baseline by clearing the baseline. You may want to do this if, for 

example, the project has been completed and you want to use the project plan as a template for a future 

project. Project removes all the baseline values from the project plan. You cannot remove some baseline 

values but leave others. 
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5.2.4 Show, hide progress line. 
Unless you want to view the progress lines at the current date then firstly you set the status date. This 

tool is in the Project ribbon in the Status group. Click the Status Date tool and select the desired date. 

Having decided on a date move the mouse pointer into the Gantt Chart area and right click then click the 

Progress Lines tool. Click the Display check box in the Progress Lines dialogue box. 

 

 

5.2.5 Show, hide columns like: %complete, fixed cost, deadline. 

 

5.2.6 Sort, filter tasks. 
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5.2. 7 Update task progress.  
Update task progress is found in the Task Information dialogue box. You display this from the Task ribbon 

Task group Information tool  

 

  

19 Task Information dialogue boxes 



  

[Type text] 
 

5.2.8 Reschedule incomplete work. 
On the File tab in the Project group select the Update tool. This displays the Update Project dialogue 

box. From here check the Reschedule remaining work after radio button. Set the date as required. 

 

 

5.2.9 Display current project schedule and baseline. 
First ensure you have created a baseline. Task tab Task group Save Baseline tool. 

The baseline remembers all the parameters set in project at that point in time. 

The Original project is displayed as a grey shadow under the current Gantt line 

Note: It is best if your project is as complete as possible before you set the baseline. This will insure your 

project monitoring is as efficient as possible 

Once the baseline has been set it is then possible to compare the current project schedule relative to that 

baseline.  

 

 

 

 

Colour codes for the horizontal bars are: 

Blue – Current tasks 

Grey Baseline 

Red Critical tasks  
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6 Prepare Outputs   

6.1 Setup   

6.1.1 Change page orientation: portrait, landscape. Change paper size.  
Page Orientation is set in the Preview dialogue box.  

 

6.1.2 Change page margins: top, bottom, left, right. 
Page Margins are set in the Preview dialogue box Margins, seen 

above. 

6.1.3 Prepare a Gantt chart, network diagram for print 
using options like: columns to print, notes. 
Please can someone help me with this? 

6.2 Print   

6.2.1 Preview a Gantt chart, network diagram, report.  
In order to preview a Gantt Chart, Network diagram WBS or other 

view it is first necessary to select the appropriate view then click File > 

Preview. The preview is then displayed in the preview window. From 

the Preview window you can create a pdf of your work or indeed print 

it using the options in the Preview dialogue 
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6.2.2 Print a Gantt chart, network diagram, report from an installed printer using 
output options like: entire document, specific pages, number of copies.  
 

Provided a printer is installed, select the view you want click the File tab then click Preview to check what 

you will print and maybe set the options shown above. If you’re happy click Print or to get a .pdf 

document click PDF 

Printing options (Settings) allow the printing of the entire project, specific dates and specific pages. It is 

also possible to print a range of pages covering a particular timescale. 

Multiple copies can also be printed. 
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Project Ribbons 

The File menu in ProjectLibre  

 

 

Task Ribbon 

 

Resource Ribbon 

 

View Ribbon 
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Glossary 
  

  

  

Assignment A particular resource that is assigned to a 

particular task. 

Baseline An approved plan for the project (schedule) 

baseline plan These are the original project plans [up to 10 per 

project] used to track progress on a project. The 

baseline plan is a snapshot of the schedule at the 

time that you save the baseline and includes 

information about tasks, resources, and 

assignments. 

CCB Change Control Board 

Change Management A project management plan to control the scope 

of the project and to keep it on course 

Gantt Chart A graphical display of the schedule 

Levelling delay The amount of time that an assignment or task is 

to be delayed from the original scheduled start 

date as a result of resource levelling or of 

manually entering a levelling delay. 

Master Project A project containing other projects [known as 

inserted projects or subprojects]. Also called a 

consolidated project. 

Milestones A significant point in time or an event. Usually 

identified with a black diamond. 

Over allocation The result of assigning more tasks to a resource 

than the resource can accomplish in the working 

time available. 

PDF Portable Document Format 

Project Life Cycle Initiating Planning Executing (Including 

Monitoring and Controlling) 

RBS Resource Breakdown Structure 

Risk Mitigation Risk response planning techniques associated 

with threats. Designed to reduce their probability 

and/or impact. 

Schedule The timing and sequence of tasks within a project. 

A schedule consists mainly of tasks, task 

dependencies, durations, constraints, and time-
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oriented project information. 

Split Task A task whose schedule is interrupted. For 

example, a two-day task that does not require 

contiguous work days might be split so that the 

first day of work is scheduled for Monday, and the 

second day is scheduled for Thursday. 

Stakeholders People or organisations actively involved or 

affected by the project 

Triple Constraint  

WBS Work Breakdown Structure. A model of the 

project in a hierarchical structure. 
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